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Basic Business Environment 
Analysis  
Using thematic maps to find opportunities 
and threats  
—by Fred L. Miller 

Introduction 

Problem 

Janice Brown and Steven Bent plan to open a new home center in the Minneapolis-St. Paul area. The 
center, called Living in the Green Lane,1

To develop a business plan for this enterprise, Janice and Steven must analyze the market 
environment in the Twin Cities area to determine if this area will support such an enterprise. This 
analysis involves seeking out "green" customers, identifying potential competitors, examining 
transportation patterns, and pinpointing retail centers that draw consumer traffic. 

 will offer a variety of environmentally friendly building 
products, home improvement products, and construction technologies. 

Janice and Steven have discovered that green customers tend to have higher levels of income, 
education, and home value than the general population of the United States. They have directed 
you, in your capacity as the firm's business geographic information system (GIS) analyst, to use GIS 
resources to explore the distribution of households with these characteristics in the Minneapolis-St. 
Paul market area to determine if it can support their business plan. 

Specifically, you will use color-coded mapping and symbology tools to map these relevant 
demographic characteristics in the planned market area. 

                                                        
1 The organizations and people in this SpatiaLAB are fictional.  Any resemblance to actual individuals or 
organizations is coincidental. 
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Location 

Minneapolis-St. Paul core-based statistical area 

Time to complete the lab  

Four to six hours 

Prerequisites 

An understanding of the importance of environmental scanning in the process of developing 
marketing strategy 

Access to Esri Business Analyst™ Desktop Premium 10   

Data used in this lab  

 Demographic and consumer spending data at various levels of geography 
 Major highways and streets 
 Business listings 
 Shopping center listings 

Student activity 

This lab focuses on environmental scanning and market area analysis. The basic environmental 
scanning question is whether a market area offers a substantial potential market for the firm's 
products and services. This question is inherently spatial. The service area for the enterprise is 
spatially limited, while clusters of attractive consumers are distributed unevenly across the market 
area. The question then becomes whether there are clusters of attractive customers of sufficient 
size to support the enterprise. 

In this case, Janice and Steven have identified several segments of green consumers, some of whom 
are motivated by environmental concerns and others who require rapid payback of investments in 
green technologies from energy savings. They believe the most attractive segments will be True 
Blue Greens consumers, who are largely in the first category, and Green Back Greens consumers 
who are in the second (Schaefer 2007). Demographically, these segments are characterized by 
higher levels of income, education, and home value than the general population in the United States 
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(Kannan 2007). These are the characteristics you will use to assess the ability of the Minneapolis-St. 
Paul market area to support a Living in the Green Lane store. 

In this lab, you will focus on displaying, classifying, and symbolizing the distribution of these key 
demographic characteristics across the Twin Cities area using wizards and GIS layer properties. 
Specifically, you will use these tools to 

 Focus on the Minneapolis-St. Paul market area. 
 Extract data on the demographic characteristics that distinguish this firm's target 

customers. 
 Use various symbology, labeling, and formatting tools to display this data in map layers. 
 Use data normalization and classification schemes to represent this data meaningfully. 

 
At the conclusion of this lab, you may be required to submit written answers to the questions in the 
exercises or prepare a written project covering both the basic and advanced labs comprising 
business environment analysis. 

Conventions used in the data 

CBSA Core-based statistical area 

CY Current-year data  

FY Future-year projections, which are five years beyond the current year 

HH Household 

Prepare your workspace 

This lab uses Business Analyst™ Desktop Premium 10 to perform the analysis. To prepare for it, you 
should confirm that this software is available on your workstation. 

OPEN A PROJECT AND CREATE A STUDY AREA  

You will use Esri® Business Analyst to provide a range of tools for performing color-coded (also 
called thematic) mapping and managing the symbology with which data is displayed. 

1 If you have not already done so, copy the LITGL Minneapolis St Paul project folder to the  
C:\My Output Data\Projects\ folder on your hard drive. 

2 Click Start » Programs » ArcGIS » Business Analyst » BusinessAnalyst.mxd to run ArcMap™. 



Basic Business Environment Analysis: Using thematic maps to find opportunities and threats Fred L. Miller 

 4 

3 Load Business Analyst Extension, load the default map, and display Business Analyst Desktop 
Message Center. 

4 Under Recent Projects, click the LITGL Minneapolis St Paul project to select it and close Message 
Center. 

 

Your screen will resemble the default map below. It displays a map of the United States and 
several of the country's major cities. Notice in the table of contents on the left that the map has 
three group layers named Business Analyst Network Barriers,  Business Reference Layers, and Map 
Layers. Map Layers includes several additional group layers, each composed of several layers 
whose visibility depends on the scale and the extent of the map. 

You may toggle the display of all the layers in a group layer by selecting and unselecting the 
group layer title. In addition, you may expand or contract the group layers to control how much 
of the table of contents is visible. The same is true of individual layers. For example, turn on and 
expand Demographic Layers. Then expand the State Areas layer to view the Legend for the 
current map, which indicates that it is displaying state values for Median Household Income. 
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The project file for your work is ready. Within it, you will now define a study area for your 
analysis—in this case, the Minneapolis-St. Paul-Bloomington core-based statistical area. 

5 Click the drop-down box on the toolbar and click Study Area to open Study Area Wizard. In the 
first screen, select Create New Study Area and click Next. 

6 Select By CBSA from the available options, select From a list, and click Next. Select Minneapolis-St 
Paul-Bloomington, MN-WI from the options, move it to the right box with the arrow key, and 
click Next. 

 

7 Enter LITGLMinnStPaul in the Name box and an appropriate description in the Comments box. 

8 Click Finish. 

Several things happen. The map zooms to the study area you have created, which is outlined in 
a bold border. It is also added as a new group layer to the table of contents. Within the study 
area, major freeways and the boundaries of the Minneapolis-St. Paul area are displayed. 

Look at the table of contents to see why. 
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9 Expand Freeways under Transportation in the Map Layers group layer. 

Note the difference in the selection boxes for the State View and Interstates layers. The lighter 
color and small bottom bar of the Interstates and Streets (Regional) layers indicate that they are 
available but not displayed at all scales. This scale dependency, which you can customize in a 
layer's properties, means that different layers will be displayed as you zoom in and out of the 
map. These settings ensure that the more detailed layers appear only on larger-scaled maps, 
where they are more discernible and useful. 

 

You have created a project and study area for this study. You will now clip the data layers in the 
table of contents to the shape of the study area. This will make your thematic maps easier to 
read and concentrates users' attention on the area of interest. 

10 Right-click anywhere in the map area. Click Data Frame Properties and then click the Data Frame 
tab. 
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11 In the bottom half of the dialog box under Clip to shape, select Enable and click the Specify Shape 
button. On the Data Frame Clipping dialog box below the Data Frame Properties box, select Outline 
of Features, and then select LITGLMinnStPaul in the Layer box. 

12 Click OK and then click Apply. 

 

All the features have been clipped to the boundaries of the study area, which appears against a 
blue background. You will change the background color to white. 

13 On the Data Frame Properties box, click the Frame tab and, about halfway down, click the drop-
down arrow to the right of the Background box. Set the background color to white. Click OK to 
apply the setting and close the box.  
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Your map should resemble the one below. You are now ready to begin symbolizing population, 
retail, and competitive information within the study area. 

 

You will now save this map document so you can return to it easily. 

14 Click File and click Save As. Navigate to the C:\My Output Data\Projects\LITGL Minneapolis St 
Paul\CustomData\ChapterFiles\Chapter2 folder where you wish to save the map document. 

15 Enter LITGLBusinessPlan1.mxd in the File Name field and click Save. 

CREATE A CHART MAP OF HOMEOWNERSHIP  

One way to develop thematic maps is by using the wizard provided by the system. You will use this 
wizard to display homeownership rates at the county level within the study area. 

1 Check the box to the left of the Demographic Layers group layer, expand this group layer, and 
uncheck the box to the left of the ZIP Codes layer. 

2 Expand the drop-down menu of the toolbar, click Maps, and then click Advanced Thematic 
Mapping to open the Thematic Mapping wizard. 

3 In the drop-down box, select County Areas (not County Boundaries) as the layer you wish to 
symbolize. Click Next. 

4 In the next window, select the Show a chart in each area option and select Pie Chart from the 
drop-down box. Click Next.  
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5 Select the attributes Current Year (CY) Owner Occupied HUs, CY Renter Occupied HUs, and CY 
Vacant Housing Units in the box on the left side of the window. 

6 Click the single arrow button to move these attributes to the right box to include them in each 
pie chart. Click Next. 

The attribute names here use CY for current-year data and FY for future-year projections. The GIS 
provides annual updates for its demographic and Tapestry™ Segmentation datasets; the data names 
listed in the images in this lab may include years different from those you encounter in the software. 
The CY/FY convention, therefore, will allow you to use the appropriate data attributes in spite of this 
variation. 

 

7 Select a color scheme from the available options and then click Finish.  
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The wizard will process your settings and produce a map of the counties in the Twin Cities 
CBSA. Each county contains a pie chart displaying the portion of housing units occupied by 
owners and by renters as well as vacant housing units. Your map should resemble the one 
below, though the colors may differ. 

If this map isn't displayed immediately, confirm that the Demographic Layers group layer is turned on 
and that only the County Areas layer is turned on. 

 

Data for each county is displayed by pie charts, but several of these pie charts are hidden 
behind other features and county boundaries and are not clear. You will turn several layers off 
and adjust the properties of the County Areas layer to correct this. 

8 In the table of contents, uncheck the boxes to the left of the Transportation and Hydrology layers 
to turn them off and make the map less cluttered. 

9 Double-click the County Areas layer to open its Layer Properties window, which will display the 
Symbology tab. Click the colored box just to the right of the Background field to open the Symbol 
Selector window. 
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10 In the Symbol Selector window, set Outline Width to 2 pixels and Outline Color to Black. The 
window should resemble the one below: 

 

11 Click OK. 

The map will now resemble the one below, though the colors may vary: 

 

Review the charts for each county. For Living in the Green Lane, homeowners, who are more likely 
to invest in major projects than are renters, are primary target consumers. Renters are a secondary 
market with interest in making smaller investments in energy-saving technology to lower utility 
costs. While there are variations in the percentage of owned homes across the area, this map 
indicates that the overall level of homeownership is high, a favorable market indicator for the firm. 
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CREATE A MAP OF MEDIAN HOME VALUE  

Home value is another dimension of the green consumer profile identified by Janice and Steven. 
Owners of high-value homes are more likely to invest in environmentally friendly renovations and 
to have the financial resources of income and home equity lines of credit to allow them to do so. You 
will create a thematic map of median home value to display the distribution of this attribute within 
the study area. 

1 Uncheck the County Areas layer to turn it off. Expand the drop-down menu of the toolbar, click 
Maps, and then click Show/Hide Color-Coded Maps Toolbar.  

 

The toolbar opens on top of your map. You may dock it to other parts of the user interface if you 
wish. 

2 Expand the drop-down box for the Layer field. Note that some geographies are available for 
selection, while others provide the option to zoom in to see them. This scale dependency is 
designed to present attribute data at geography levels appropriate to the map's scale. 

3 Select ZIP Codes as the layer you wish to symbolize. A new layer is added to the table of contents, 
and the map display is updated. 

4 Expand the drop-down box for the Variable field to reveal a list of attribute groups in the project 
dataset. Expand and contract these groups to review the range of data available for color-coded 
mapping. 

5 You wish to map home value, so enter median value in the Search field at the bottom of the 
window, and then select CY Median Value: Owner HU as the variable to map. 

The map is immediately updated. Your window should resemble the one below, though your 
lists, Most Used Variables and Recently Used Variables, will be different. 
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6 Expand the Colors drop-down box and select a color ramp with which to display the chosen 
data. When you select a new color ramp, the map is immediately updated. 

Your map should resemble the one below, though your color choice may vary: 

 

Look at the legend of this map in the table of contents. There are several levels in the layer 
classification scheme, but it is not clear how they were derived. Moreover, variations in color 
are difficult to distinguish on the map, and some classes seem to include very few ZIP Codes, a 
function of the Natural Breaks classification scheme. You will adjust the classification scheme to 
enhance the map's communication value. 

7 Expand the More Options drop-down list at the right of the Color-Coded Maps toolbar. 

8 In the drop-down box for the Method field, select Quantile as the classification method. In the 
drop-down box for the Classes field, select 4 as the number of classes. 

Your map will be redrawn immediately to resemble the one below, though your color scheme 
might vary: 
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Notice that the number of classes has been reduced to four and the map is easier to understand. 
The number of ZIP Codes in each class seems more balanced. In the Quantiles classification 
method with 4 Classes, the selected geographic units within the map's extent are divided into 
four classes each with the same number of units, plus or minus one. Thus, the units with the two 
darkest colors are above the median value for this variable, and those with the lightest two 
colors are below it. 

9 Check the box to the left of the County Areas layer to turn it on. The pie charts you created in 
that layer now appear on top of the new map. This allows you to explore homeownership and 
home value patterns simultaneously. As you may wish to return to this point in your analysis, 
you will set a bookmark here. 

10 Click Bookmarks on the menu bar and then click Create to open the Spatial Bookmark dialog box. 
Enter HomeOwnValueMap as the bookmark name and click OK. 

11 Click Bookmarks again to confirm that this bookmark appears in the initial list under the 
Manage command. 

12 Click File » Save or the Save icon to update the saved version of the map. 

Use these maps to answer the following question in your project report: 

Question 1:  What variations in homeownership and median home value do you observe in this study 
area? Which parts of the region are most attractive for Living in the Green Lane? Why? 

CREATE A MAP OF HOME MAINTENANCE EXPENDITURES  

You also wish to examine the level of home-related expenditures in the Twin Cities area. To do so, 
you will create a thematic map displaying the average home maintenance materials purchases per 
homeowner. You will use the mapping options of the Color-Coded Maps toolbar to do so. 

1 Expand the drop-down box for the Variable field to reveal a list of attribute groups in the 
dataset.  

2 Enter remodel in the Search field. Expand the CY Consumer Spending category and then click 
Home Imp Material-Own & Rent: Tot:Tot (total purchases of home improvement materials by 
homeowners and renters). The map updates immediately. 

3 Expand the Colors drop-down box and select a color ramp with which to display the chosen 
data. When you select a new color ramp, the map is immediately updated. 

4 Expand the More Options drop-down list at the right of the Color-Coded Maps toolbar. Confirm 
that Quantile is selected in the Method field and 4 is selected as the number of classes. 
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Note the options in the upper left of the More Options window. These allow you to select 
whether you wish to map this attribute as total expenditures in each geographic area, average 
expenditures per household in that area, or an index related to the average national value for 
that attribute. The last of these options, Index, the national average level of household 
expenditures, is assigned a value of 100. Geographic units with indexes over 100 spend at a 
level above that national rate; those with indexes below 100 spend at a level below that rate. 

 

5 Select each of these options and notice the effect on the map. When you are finished, select the 
Avg option to move to the next step. 

6 Expand the Layer field drop-down box. 

Notice that you must zoom in to display the purchasing data at the block group level. 

7 Click the Zoom In option to do so. 

8 Pan around the map and notice that the class boundary values in the legend change as you do so 
because the quantile classification method is applied to the block groups in the map's current 
extent. 

9 To retain the same values as you pan, expand the More Options drop-down list and select the 
Lock ranges while panning option. This allows you to pan around the block group map without 
changing the range boundaries displayed in the layer's legend. 
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10 Return to the ZIP Code layer and zoom out to view the entire study area. Your map should 
resemble the one below, though your color scheme might vary: 

 

You wish to save the Color-Coded ZIP Codes layer for use in other projects. 

11 Right-click the Color-Coded ZIP Codes layer to save the layer for use in other projects. 

12 Click Save as Layer File and navigate to C:\My Output Data\Projects\LITGL Minneapolis St 
Paul\CustomData\ChapterFiles\Chapter2. Then save the layer file as ZIPHomeExpenditures.lyr. 

You may now add this layer to this or any other map document by clicking the Add Data button, 
navigating to this folder, and double-clicking this layer file. 

13 Save the map file again to preserve your work. 

Use the ZIP Code and block group color-coded maps you created to explore the patterns of 
home improvement expenditures in the Minneapolis-St. Paul area and answer the following 
question: 

Question 2:  What is the difference between mapping total home improvement expenditures by ZIP 
Code and average home improvement expenditures per household by ZIP Code? How can each help you 
understand the distribution of these expenditures in the market area?  

You have now created maps displaying the patterns of homeownership, home value, and home-
related expenditures per household in the Twin Cities area. Review these maps to identify 
concentrations of high home values and/or home-related expenditures. These represent areas of 
opportunity for Living in the Green Lane. You must now create a layer displaying the distribution of 
household income to include this dimension of the green consumer profile. 
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CREATE A MAP OF HOUSEHOLD INCOME                                                                                                                                      

With business GIS software, thematic mapping may also be performed with Symbology options in 
the Layer Properties window. Now you will use this approach to create thematic maps of household 
income at the block group level in the Twin Cities core-based statistical area. 

1 Turn off the County Areas layer.  

2 Right-click the Block Groups layer and click Properties (or double-click the layer) to open the 
Layer Properties window. Click the Symbology tab. 

3 In the Value box, select CY Median HH Income. 

4 Click OK in response to the Maximum sample size message. 

5 To the right of this box, click the Classify button to open the Classification dialog box. 

The Classification dialog box provides significant information about the data values for this 
attribute. The top right of the box presents descriptive statistics for the attribute. Note that it 
includes 10,000 records, a sampling of the block groups in the dataset, which are themselves a 
small part of the more than 200,000 block groups in the United States. 

You may increase this sample size by clicking the Sampling button. The graph in the bottom left 
of the box displays the distribution of values for the attribute. The lines represent the class 
boundaries of the current classification scheme. The corresponding values are listed in the box 
to the right. 

Try moving one of the lines with your mouse or entering values directly into the list. 

The classification scheme changes to Manual, and the class boundaries are adjusted accordingly. 
This allows you to customize class boundaries to specific values of importance to your project. 
By clicking the Mean and Standard Deviation options, you may elect to display these statistical 
measures as lines in the distribution chart. 

Note the Classification Method and Classes boxes at the top left of the dialog box. These allow you 
to set the classification method and number of classes for the map. When you change these 
settings, the revisions are immediately reflected in the chart and Break Values box. 

Experiment with different methods and numbers of classes to see the impact of these settings. 
You may even wish to click OK and Apply to see the impact of these changes on the map. 

You wish to display median household income in a quartiles method with half the features 
above the median feature value and half below. 
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6 Select Quantile in the Methods box and 4 in the Classes box, the same settings you used earlier on 
the Color-Coded Maps toolbar. 

7 Click OK to return to the Symbology tab of the Layer Properties window. 

 

8 In the Color Ramp box, select a Green to Blue color scheme. 

Note that attribute values are listed from highest to lowest. 

9 As you wish the higher values to be displayed in green, click the Range column header and click 
Reverse Sorting. 

10 Click the Label column header to the immediate right of the Range column header and click 
Format Labels.  

11 In the resultant dialog box, click Currency and then click OK.  

12 Check the Show class ranges using feature values box below the Symbol column to use actual 
values in the data as class boundaries. 
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The Symbology tab should resemble this: 

 

13 Click OK to close the Layer Properties box and apply the settings to the map. Your map should 
resemble the one depicted: 

 

Use the thematic maps you have created to answer the following question in your project 
report: 

Question 3:  What variations in median household income and home maintenance expenditures do 
you observe in this study area? Which parts of the region are most attractive for Living in the Green 
Lane? Why? 
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Submit your work 

Submit answers to the following questions: 

Question 1:  What variations in homeownership and median home value do you observe in this study 
area? Which parts of the region are most attractive for Living in the Green Lane? Why? 

Question 2:  What is the difference between mapping total home improvement expenditures by ZIP 
Code and average home improvement expenditures per household by ZIP Code? How can each help you 
understand the distribution of these expenditures in the market area?  

Question 3:  What variations in median household income and home maintenance expenditures do 
you observe in this study area? Which parts of the region are most attractive for Living in the Green 
Lane? Why? 

Credits 

Data 

Data displayed in screens captures of Business Analyst is courtesy of Esri; the US Census Bureau; 
Infogroup; the Bureau of Labor Statistics; Applied Geographic Solutions, Inc.; Directory of Major 
Malls, Inc.; GfK Mediamark Research & Intelligence, LLC (GfK MRI); and Market Planning Solutions, 
Inc.  
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Instructor resources 

Contextual information 

This lab is written for business students in an integrated business GIS course at the undergraduate 
or graduate level. It may be used to replace the exercises in chapter 2 of Getting to Know ESRI 
Business Analyst in labs with Business Analyst Desktop Premium 10 installed. The emphasis is on 
the spatial analysis of factors that determine the attractiveness of a market area for a specific 
enterprise relative to its marketing strategy and objectives. This is a common objective of the 
environmental scanning and market planning process, especially for startup entrepreneurial firms. 
Thus, this lab is also useful as a stand-alone exercise in entrepreneurship or marketing strategy 
courses. 

This lab shows how to map demographic and consumer expenditure patterns within a market area 
as well as the distribution of competing and supporting business entities across the area. It also 
shows how to identify attractive clusters of potential customers based on a set of defined 
characteristics. 

Upon completion of the lab, students may be required to submit answers to several questions based 
on their observation of the thematic maps they have created. 

Analysis and visualization tools 

Business Analyst Desktop Premium 10 and the Living in the Green Lane Minneapolis St Paul project 
file are required to complete this exercise. 

Data information 

All the data for this exercise is provided by Business Analyst Desktop. 

Data sources 
Esri Business Analyst data 
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Answer key 

Question 1:  What variations in homeownership and median home value do you observe in this study 
area? Which parts of the region are most attractive for Living in the Green Lane? Why? 

The counties in the central, southeastern, and eastern parts of the market area have the lowest rates 
of homeownership. Higher rates are displayed for block groups in the north, west, and southwest. 
Homeownership is above 50 percent of housing units across the market area. 

The block groups with the highest median home values are largely in the southern half of the market 
area, with some concentration to the southwest. The block groups in the north of the market area 
display values in the middle two classifications, while those in the center of the market area are largely 
in the lowest classification. 

Question 2:  What is the difference between mapping total home improvement expenditures by ZIP 
Code and average home improvement expenditures per household by ZIP Code? How can each help you 
understand the distribution of these expenditures in the market area? 

The total home improvement expenditures attribute reports total spending for the entire ZIP Code and 
is a good measure of market size. The average expenditures per household option divides this total by 
the number of households in each ZIP Code and is a measure of the level of spending in each individual 
household. In combination, these measures help Living in the Green Lane understand whether a 
market area offers a high number of households with low annual purchases or a small number of 
households with higher levels of purchases. This difference affects the merchandising and promotion 
strategies that Living in the Green Lane should use to serve potential customers. 

Question 3:  What variations in median household income and home maintenance expenditures do 
you observe in this study area? Which parts of the region are most attractive for Living in the Green 
Lane? Why? 

The block groups with the highest levels of median household income are in an uneven ring outside the 
center of the market area, with a bit more concentration in the south. They are surrounded by block 
groups with medium income levels on the outside of the area. Block groups with the lowest levels of 
median household income are concentrated primarily, but not exclusively, in the central part of the 
market area. 

The distribution of home-related expenditures per household follows the same pattern, indicating a 
potential relationship between these two attributes. 

Additional notes 

1. This SpatiaLAB updates the student exercises in chapter 2 of Getting to Know ESRI Business 
Analyst (Miller 2010) for Business Analyst Desktop  Premium 10. However, it may be used as 
a stand-alone exercise. 
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2. Though this lab is integrated with the Advanced Business Environment Analysis SpatiaLAB to 
create a complete project, it is not necessary for students to complete that SpatialLAB to 
work with this one. Should you wish to use this lab as a stand-alone exercise, you should 
choose the reporting option of having students submit answers to the lab's questions, as 
they will not have sufficient information to complete a full project report. 

3. It is useful for students to experiment with different classification schemes for these data 
layers, noting how changing the classification scheme can change the visual impression of 
the mapped data while presenting exactly the same data. 

4. This lab incorporates only a few of hundreds of available attributes. Encourage students to 
explore additional attributes by posing different scenarios in which different enterprises use 
varying combinations of attributes to define attractive customers. 

5. The Color-Coded Maps toolbar allows you to create maps for Market Potential Indexes (MPI) 
attributes and additional consumer expenditure variables that are not available in the 
approaches described in this lab. This allows students to map a whole range of consumer 
values, behaviors, media consumption, and purchasing patterns that are of great interest to 
marketers. Invite students to select an MPI attribute such as HHs: Home remodeling done/yr 
(households remodeling their home in the past year); map the number, percentage, and 
index values for this attribute; and explain the relevance of each measure. 

6. For several of the most common attributes, data is available from the 1990 and 2000 
censuses as well as current-year estimates and five-year projections. In addition, some 
attribute data contains rates of annual growth or annual change in other attributes. Help 
students understand how these data resources can be used to track changes over time in key 
market area characteristics. 

7. Instead of—or in addition to—answers to lab questions, you may wish to have students 
complete a more comprehensive report covering multiple labs. If so, you may wish to use the 
following structure and guidelines for that report. Feel free to adjust this format to your 
preferences or class requirements. 

Report format 

Aim for reports of about six to eight pages in length and consider the following format: 

I. Introduction—A summary of the circumstances addressed by the research project 
II. Problem statement—A statement of the problem addressed by the project 
III. Data information—A statement of the sources and dates of all data used in the analysis 
IV. Analytical methods—A description of the analytic procedures used and how they will help 

solve the problem 
V. Research results (the largest section of the project)—To include 

A. Presentation of the results of the analysis 
B. Exhibits such as the required maps, charts, and tables and any others you wish to 

include to clarify your report  

VI. Conclusions and recommendations—A recommended response to the problem based on 
the results of the analysis 
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Business GIS references 

BusinessGeoInfo newsletter. 
http://www.esri.com/industries/business/community/newsletter.html 
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Esri. 2010. Esri Demographic Update Methodology: 2010–2015, an Esri white paper. 
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http://www.giscafe.com/ 
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Publishing. 

Pyke, Chris. 2010. GIS Assists Green Building (podcast). 
http://www.esri.com/news/podcasts/podcast.html#user_pyke 

Roderick, Brent. 2009. "Discover Retail Opportunities with Esri's Retail Marketplace Data." 
ArcWatch, August. 
http://www.esri.com/news/arcwatch/0809/retail-marketplace-data.html 

Romeo, Jim. 2005. "Target Marketing with GIS." Geospatial Solutions, May: 3–5. 
http://www.tetrad.com/pub/documents/geospatial.pdf 

http://www.esri.com/industries/business/community/newsletter.html�
http://www.directionsmag.com/�
http://www.esri.com/industries/business/index.html�
http://www.esri.com/library/casestudies/southbend.pdf�
http://www.esri.com/library/whitepapers/pdfs/demographic-update-methodology-2010.pdf�
http://www.esri.com/library/whitepapers/pdfs/demographic-update-methodology-2010.pdf�
http://www.esri.com/library/whitepapers/pdfs/trend-analysis-2010-2015.pdf�
http://www.giscafe.com/�
http://www.esri.com/news/podcasts/podcast.html#user_pyke�
http://www.esri.com/news/arcwatch/0809/retail-marketplace-data.html�
http://www.tetrad.com/pub/documents/geospatial.pdf�


Basic Business Environment Analysis: Using thematic maps to find opportunities and threats Fred L. Miller 

 25 

Schaefer, Paul. 2007. "New Study: Americans Reach Environmental Turning Point, Companies Need 
to Catch Up." Environmental News Network, August 22. 
http://www.enn.com/top_stories/article/22186 
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